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Comment installer Quartus

1. Aller surle site d’Intel

Avec le lien suivant : downloadcenter.intel.com/fr

Vous trouverez la page d’accueil ci-dessous :



intel PRODUITS ~ SUPPORT  SOLUTIONS  DEVELOPPEURS  PARTENAIRES R Preacerngan Q. Rechercher surIntel.com

PILOTES ET LOGICIELS

Produits » Pilotes et logiciels lom du produit ou mot clé ﬂ

Mettre automatiquement a jour vos pilotes

Identifiez vos produits et obtenez des pilotes et mises a jour logicielles pour votre matériel Intel.

Démarrer

Choisissez votre produit

Solution graphique "‘:“ Réseaux sans fil % Produits Ethernet
= TR [ TN o ,u:

2. Création de votre compte

La création de votre compte est obligatoire pour avoir acces aux différents outils proposés par le site.
Pour cela, cliquez sur I'icone présent dans I'entéte :

£ ona Q. Rechercher sur Intet.com

MM PRODUITS  SUPPORT  SOLUTIONS  DEVELOPPEURS  PAR

PILOTES ET LOGICIELS
Produits » Pilotes et logiciels Q]

Créez un compte de base :

m PRODUITS SUPPORT SOLUTIONS DEVELOPPEURS PARTENAIRES

Se connecter

Q. Rechercher sur Intel.com

Travaillez-vous pour Intel 7 Inscrivez-y

Nom d'utilisateur Mot de passe ‘avez pas de compte Intel 7 Inscr ici pour un compte 8

En vous inscrivant, vous acceptez nos Conditions de service.

Se connecter Se souvenir de moi

Vous avez oubli€ votre nom d'utilisateur cu mot de passe?

Il faudra ensuite remplir un formulaire avec vos coordonnées.

3. Cherchez Quartus Prime Software Support dans labarre de recherche



DEVELOPPEURS PA

Q_ Rechercher sur Intel.com

intel PRODUITS  SUPPORT 50

PILOTES ET LOGICIELS

Mettre automatiquement a jour vos pilotes

Identifiez vos produits et obtenez des pilotes et mises a jour logicielles pour votre matériel Intel.

Cliquez sur I'onglet « Tous les résultats » puis sur le lien Quartus Prime Software Support :
W PRODUTTSSUPTUR SUTUTTUNSDET LU RS TRRTERRES =TT =

Q. Quartus prime ”

Tous les résultats Produits Assistance Téléchargements Caractéristiques techniques Développeurs Partenaires l

76609 Résultats — Se connecter pour accéder au contenu confidentiel

Quartus Prime lite

commurity intel.com/t5//

tel-Quartus-Prime-S e/Quartus-Prime-1ite/

Date : 01/09/2020

Quartus Prime lite So I'm able to download Quartus Prime Lite on to my laptop but it won't let me ... Can someone help me find a better way to run this

software through my laptop without ...

v Show replies

/lz

Puis cliquez sur le logiciel gratuit a télécharger :

Using Intel Quartus Prime and Quartus || Software Intel Quartus Prime Software Resource Centers

Overview

¢ Intel Quartus Prime Software Handbook

Installation and Licensing
» Quartus Il Design Examples =

Scripting
r Online Training e

Board Design and /O
+ Intel Quartus Prime Software Help - !

Design Ent

and Planning

Download

Synithesis and Netlist Viewers
+ Intel Quartus Prime and Quartus |l software or updates

[- Intel Quartus Prime Lite Edition 50‘twa'eﬁ]ﬂ‘__

Product and Ordering Information

Incremental Compilation

Optimization

Power Management

¢ Imtel Quartus Prime Software Product Infarmation

Timing Analyzer

» Operating System Support

Classic Timing Analyzer

» What's New in Intel Quartus Prime Software

Simulation and Verification

» Compare Intel Quartus Prime Software Editions

On-Chip Debugging

Technical Support and Resources

HardCopy® Design

» Use mySupport to submit and manage service requests EDA Tool Support

+ Use the Intel community forum for general FAQs

4. Télécharger le logiciel Quartus

Sélectionnez I'édition : lite
Prenez la version la plus récente dans « select release »
Puis sélectionnez le systeme d’exploitation de votre ordinateur



PRODUCTS SUPPORT SOLUTIONS DEVELOPERS PARTNERS /_og @US“‘:E’\EUEW Q. Search Intel.com

Home > Downloads > Quartus Prime Lite Edition

Download Center for FPGAs

P — Quartus Prime Lite Edition
Intel Quartus'Prime
Latest Release: v20.1 Desi
Programming Software Select edition:
Selectrelease:
Board System Design

Board Layout and Test Operating System @ @£/ Windows O 6 Linux

Cliquez sur « Combined files »

Board System Design
Board Layout and Test Operating System @ k_,’ Windows C ,"_\ Linux
Legacy Software

« The Quartus Prime Lite Edition Design Software, Version 20.1 includes functional and security updates. Users should
keep their software up-to-date and follow the technical recommendations to help improve security. Additional security
updates are planned and will be provided as they become available. Users should promptly install the latest version upon
release,

«' The Quartus Prime Lite Edition Design Software, Version 20.1 is subject to removal from the web when support for all
devices in this release are available in a newer version, or all devices supported by this version are obsolete, if you would
like to receive customer notifications by e-mail, please subscribe to our subscribe to our customer notification mailing list.

« The Quartus Prime Lite Edition Design Software, Version 20.1 supports the following device families: Arria Il, Cyclone
10 LP, Cyclone IV, Cyclone V, MAX IL, MAX V, and MAX 10 FPGA. - More

—

Download and install instructions: . More

M A FNrAF e o mna sl AR

Enfin cliquez sur I'icone de téléchargement

Quartus Prime Lite Edition Software (Device support included) whars included? /

Quartus-lite-20.1.0.711-windows.tar °
Size: 5.9 GB MDS: CO(

Note: The Quartus Prime software is a full-featured EDA product. Depending on your download speed,
download times may be lengthy.

Prise en main de Quartus

1. Comment créer un projet

e Fenétre d’accueil
Pour la création d’un projet, on sélectionne I'icbne « New Project Wizard »
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Puis sélectionnez « Next »

e Fenétre : “Directory, Name, Top Level Entity”

Elle permet de choisir I'emplacement de la sauvegarde de notre projet et son nom.

Sk New Project Wizard X

Directory, Name, Top-Level Entity

‘What is the working directory for this project?

CAintelFPGA_lite\19.1 | ]
‘What is the name of this project?

test o
‘What is the name of the top-level design entity for this project? This name is case sensitive and must exactly o

match the entity name in the design file.

test =

vy

Use Existing Project Settings—.

< Back IEI Finish Cancel Help

I

Ensuite cliquez sur « Next ».

e Fenétre « Project Type »
Sélectionnez « Empty project ». Puis « Next ».

Emplacement de la
-

sauvegarde du projet

Nom du projet

Attention !

Les deux noms du projet doivent

étre identiques

Changez I'emplacement de
sauvegarde du projet pour qu’il ne
soit pas au méme emplacement que

I’ outil



O New Project Wizard

Project Type

Select the type of project to create.

@ Empy project

Create new project by specifying project files and libraries, target device family and device, and EDA tool
settings.

QO Project template
Create a project from an existing design template. You can choose from design templates installed with

the Quartus Prime software, or design from the Design Store.

< Back

Finish Cancel Help

e Fenétre « Add Files »

Ne changez rien et cliquez directement sur « Next »
O New Project Wizard b4

Add Files

:::S;:.:?:‘fr!;:(:ou want 10 include in the project. Click Add Al 1o add all design files in the project

Note: you can always add design files to the project later.

File name: - Add
- X| | aadan
File Name Type Library Design Entry/Synthesis Tool KDL Version o

up

Down
Properties

‘Specify the path names of any non-default libraries. User Libraries..

< Back Next > Finish Cancel Help

e Fenétre “Family, Device & Board Settings”
Ne rien changer sur I'onglet « Device » et aller directement sur I'onglet « Board »
O Mew Project Wizard *
Family, Device & Bedrd Settings

Device Board

Select the family and device you want 1o target for compillation
You can Install additonal device support with the install Devices command an the Tools menu,

To determine the version of the Quartus Prime software in which your target device |s supported, refer 1o the Deyice Support List webpage.
Device family Show in*Available devices' list
Family: | Cyclone V (E/GX/GT/SX/SE/ST) T package: Any B
Device: |All - Pin count: Any i

Target device Core speed grade: Any

he Name filter:

W Specific device selected In ‘Avallable devices® list [«] Show advanced devices

Avallable devices:

Mame Caore Voltage ALM3 Total 1fOs GPIOS GXB Channel PMA GXB Channel PCS ™
SCGXFCTCEUTBAT 1V 56480 268 240 ] G -
€ ¥

< Back Hext » Finish Cancel Help



O New Project Wizard

Family, Device & Board Settings
Device  Board
Sebect the Boardfdevelopment kit you want 10 target for ¢ Eho.
runrr{_ca-mrv * 1Kt Any
Avallable boards:

Hame Wersion Family Device Wendor ALM3

M Adss-SoC(. 10 CycloneV  SCSEMASUICE  Terasic 15880
M CycdoneVE- 10 CycdoneV  SCEFATFINIT Alvera 56480
M Cydone VG 10 Cyclone v SCGTFDESFISCT Alera 113560
M Cydonevs. 10 CycloneV  SCSXFOBDEF3I1CE Arrow 41910
M CycdoneVs. 10 CycloneV  SCSXFCGDEFI1CE Altera 41910
m Cyclone WV G 10 Cyclone V SCOXFCSCEF2TCY Terasic 20080
m DEO-CV De.. 10 Cyclone V SCEBALF2ICT Terasic 18480
m DEY-50C B 10 Cyclone ¥V SCSEMASFINCE  Allera 32070

L4

[ create top-tevel design file.

Total 05
34
480
616
400
400

224
457

Can find your board? Check the Deslgn Store for additions and search for baseling under Design Examples.

Family, Device & Board Settings

Device  Board

S

Select the Doard/developrment kit you want 1o target for compilation.

Family: MAX 10
Available boards:

Mame

Version

B Arrow MAX. 09

BeMicro M_

MAX 10 FP_..
MAX 10FP_..
MAX 10 ME...
Odyssey M_.

reate top-level design file.

10

10
10
10
10

Famity
MAX 10

MAX 10

MAX 10
MAX 10
MAX 10
MAX 10

= Development KT Afy

Device Vendor
1OMES0DAFS84CEGES Arrow
10MOADAFSB4CAGES Arrow

10MOASAE144CAGES Aleia
10MSODAF2S6CTG  Alera
10MS0DAF4B4ITG Terasic

49760
40TED

1DMOBSAUN GICBGES Macnica A.. BG4

Total 1fos

360
250

101
178
360
130

Canvt find your board? Check the Design Slare for additions and search for baseline under Désign Examples.

< Back
R .
o Fenétre « EDA Tool Settings »
O New Project Wizard
EDA Tool Settings
Specity the other EDA 100ls used with the Quartus Prime software 10 develop your project
EDA 1o00is:
Tool Type Tool Name Format(s) Run Tool Automatically
foeson ey joone NSNS
Simulation “<None> v <None>
Board-Level Timing <None>
Symbol <None>
Signal integrity <None>
Boundary Scan <None>
< Back Next > Finish Cancel

Help

Finish

Lo v g
14

101
178

130

Cancel

B Channg

1677}
38707

38707
16777
18773
38707

Attention a la place de

« Cyclone V » bien choisir
« Max 10 » puis dans la
liste proposée
sélectionnez « Max 10
DE... »

Attention ! : il faut
ensuite décocher

« Create Top level design
file » avant de cliquer sur

« Next »

Cliquez directement sur « Next »



2. Création d’un block diagramme
Il estimpératif de créer un block diagramme sinon vous n’aurez pas acces aux outils !
Pour cela, il faut sélectionner dans I'ordre suivant : File> New> Block Diagram Schematic File

Puis sélectionnez le seul dossier présent

3. Création des entrées et des sorties

Dans la barre d’outils sélectionnez I'icone suivant :

ENQWAD[EIOTTINNNTON AL <8

Il faudra spécifier si c’est une sortie (output) ou une entrée (input) puis aprés sacréation, vous pouvez

modifier son nom en double-cliquant dessus.

4. Les différentes portes logiques

Dans la barre d’outils, sélectionnez I'icone suivant :

TN DO N N R

Pour trouver les portes logiques de base, ouvrir le seul dossier présent puis dans I'ordre suivant :

Primitives > Logic

’rJ Symbol

Libraries:

v & cfintelfpga_lite/19.1/quart
& megafunctions
O others
& primitives

< >

Name:

Repeat-insert mode

[ insert symbol as block

Cancel

‘f Symbol

Libraries:

v & primitives
& buffer
v & logic
& and12
T and2
& and3
& and4

<

Name:

Repeat-insert mode

[ insert symbol as block

Cancel

On trouve les portes logiques de base comme la porte and, or, nor ainsi que leur nombre d’entrées

5. Les liaisons

Pour relier les entrées/sorties aux autres éléments (comme les portes logiques, les bascules...), on utilise

en générale des liaisons simples perpendiculaires

T RQYAD

-[___‘@'1 ﬁ[@\ \ OO\ ™ "=

LB

6. Création de bascule

Dans la barre d’outils, sélectionnez I'icone suivant :

Ouvrir le seul dossier présent puis dans |'ordre : Primitives > Storage




# symbol x Il'y a différentes bascules de base :

Libraries:
: - Dff:bascule D
& logic 2
& other - Dlatch : bascule D avec verrou
& pin o o Tl ]
v & storage - JKff : bascule JK
£t dff
B dfe - Tff :bascule T
& dffea e
< >
Name:

Repeat-insert mode

[ insert symbol as block

Cancel

7. Utilisation de la librairie

" & Installed IP . L. \ . .
v P':ii‘::m,emw La librairie esttrés importante carelle propose des fonctions complexes

. Lih::r:e'““" paliste connues. Les fonctions sont plus faciles a générer en allant directement dans

¥ Basic Functions la librairie plutot que de les faire soi-méme.
~ Arithmetic
¥ ALTERA_CORDIC
ALTMEMMULT
ALTMULT_ACCUM (MAC) Les fonctions se situent dans I'onglet « Arithmetic »
£ ALTMULT_ADD
ALTMULT_COMPLEX
ALTSQRT
FP_ACC_CUSTOM Intel FPGA
FP_FUNCTIONS Intel FPGA IP
LPM_COMPARE
LPM_COUNTER
LPM_DIVIDE
LPM_MULT
PARALLEL_ADD
Bridges and Adaptors
Clocks; PLLs and Resets

On trouve des fonctions telles que : le comparateur, I’additionneur, le

multiplicateur, le diviseur ...

bl

Configuration and Programming
/o

Miscellaneous

On Chip Memory

Simulation; Debug and Verification

Dés que I'on sélectionne la fonction souhaitée, il faut la configurer.

Exemple avec le comparateur:

< MegaWizard Plug-In Manager [page 1 of 5] ? X
"2 LPM_COMPARE Dans « parameter Settings » on peut sélectionner :

Parameter

- Le nombre de bits

> General2 > Pipelining >

— Currently selected device family: |\ 10 _ Les com pa raisons pOSSIb|eS
comparg] Match project/default
- dataa(7. 0]
[ dataol 01 22

o ompone ot ot s
Which outputs do you want?
(Select at least one)
a=b (equal)
[ a <> b (ot equal)
[1 a > b (greater than)
[ a >=b (greater than or equal)
[ 2 < b (less than)
[ 2 <=b (less than or equal)

Resource Usage
—




X MegaWizard Plug-In Manager [page 2 of 5] ? x

Parameter
Sel

General

comp
compareg

dataa[7..0]

datab[7..0] 220

TT
1

Parameter

General

comp

"2 LPM_COMPARE

General 2

dataa[7..0]

datab[7 0] 22

comparg

comp
compare|

dataa[7..0]

datab(7..0] 2P

TT
1

Resource Usage

Dans « General 2 », on sélectionne sil'on souhaite
’
. que la valeur de b soit constante ou variable et sila

comparaison sera signée ou non.

Pipelining

Is the 'datab' input bus value a constant?

©Nu

(O Yes, the value in decimal is 0 Dec

‘Which type of comparison do you want?

@ Unsigned
() signed

Dans « Pipelining » : il faut

cocher la case « No »

Do you want to pipeline the function?

@ Mo
() Yes, Iwant an output latency of 0 clock cycles

Create an asynchronous Clear input

Create a Clock Enable input

Dans « EDA », il ne faut rien modifier et
donc cliquer directement sur Next

Simulation Libraries
To properly simulate the generated design files, the following simulation model
file(s) are needed

File Description

Ipm LPM megafunction simulation library

Timing and resource estimation

Generates a netlist for timing and resource estimation for this megafunction. If you
are synthesizing your design with a third-party EDA synthesis tool, using a timing
and resource estimation netlist can allow for better design optimization.

Not all third-party synthesis tools support this feature - check with the tool vendor
for complete support information.

MNote: Netlist generation can be a time-intensive process. The size of the design and
the speed of your system affect the time it takes for netlist generation to complete.

[] Generate netlist

| Cancel H < Back ‘ : Next > | ‘ Einish |

comp

'Z) LPM_COMPARE

compare|
dataa[7..0]
datab[7.0] 220

Documentation

Dans « Summary » : il ne faut surtout

pas oublier de tout sélectionner, sinon

Summary

vous risquez de ne pas trouver la

fonction dans vos dossiers

Turn on the files you wish to generate. A gray checkmark indicates a file that is
automatically generated, and a green checkmark indicates an optional file. Click Finish
to generate the selected files. The state of each checkbox is maintained in subsequent
MegaWizard Plug-In Manager sessions.

The MegaWizard Plug-In Manager creates the selected files in the following directory:

C:\Users\Utilisateur\Desktop\Polytech\ESN 2-3\TEST),

File Description

comp.vhd Variation file

comp.inc AHDL Include file

comp.cmp WHDL component declaration file
comp.bsf Quartus Prime symbol file
comp_inst.vhd Instantiation template file




iW Quartus Prime IP Files x

When you create an Intel IP variation, a Quartus Prime IP File
is generated. Quartus Prime IP Files are used to represent the
Intel IP in your design. Do you want to add the Quartus Prime
IP File to the project?

C\Users\Utilisateur\Desktop\Polytech\ESN 2-3\TEST\c...

] Automatically add Quartus Prime IP Files to all projects

(Note: Turning on this option permanently suppresses this
dialog box. You can change this setting in the Options dialog
box)

Yes No Help

A la fin de la configuration de la fonction, il faut
cocher I'lP du fichier de votre projet (sinon le

logiciel ne trouvera pas la fonction)

Comme toutes les fonctions, celle-ci se trouve en cliquant sur I'onglet ci-dessous
ENe¥AD]: 013NN TON AR A A8 X0

Puis sélectionnez le dossier « Project » pour trouver la fonction complexe précédemment créée

'?J Symbol

Libraries:

v & Project
& comp
& cfintelfpga_lite/19.1/quar

comg
. compar
NURESS
< > ins’
Name:

Repeat-insert mode

[ insert symbol as block

Cancel

8. Compilation

Pour compiler, cliquez sur:

2XLY

P 2eo0aOE 9

Attention ! Bien enregistrer et ne surtout pas changer le nom du fichier a enregistrer

Puis attendez la fin de la compilation

Task
~ B Compile Design

P> Analysis & Synthesis
P> Fiuer (Place & Route)
P> Assembler (Generate programmin,
P> Timing Analysis
P> EDA Netlist Writer

W Edit seuings

» Program Device (Open Programmer)

< >

Tasks Compilation T=Es - Si tout s’est déroulé comme prévu, tous les éléments sont
affichés en vert comme dans le cas ci-contre.



9. Simulation

La simulation selance en cliquant dans I'ordre sur: File > new > university program VWF

On atterrit ensuite sur une nouvelle page:

i Simulation Wavefarm Editor - Cy/Users/Utilisateus/Desktop/Polytech/ESN 2-3/TEST/test - test - [Waveform1vwi]

File | Edit View Simulation Help

k X Delete Del |vm = B
o M _metodeortus e firagsm envat [11a3 s Cliquez dans I'ordre sur: Edit > insert > insert

Grouping v ns 1600 ns 2400 s 320005 4000 ns. 4800 ns 560,01

o nodeorbus

<

Snap to Grid
Snap to Transition

(@ Insert Node or Bus X ) .
Pour trouver les nceuds, cliquez sur « Node Finder »
Name: |Jse Node Finder to | | OK |
Type: INPUT M Cancel
Value typ |9-Level hd

Node Finder...

Radix: |Binary

Display gray code count as binary nt
Ok Node Finder x . .
Cliquez sur « List »
Named: l:l Filter: | Pins: all h
Look in: |* Il [ ust | cancel Les sorties et les entrées que I'on souhaite étudier se
ri P Selected Nodes: [stare node search situent dans la liste.
Name Type Name Type

Faire passerdans la colonne « Selected Nodes » les
>>

entrées/sorties souhaitées

<<

A la fin de cette étape, cliquez sur OK

Pour la simulation, on peut modifier les valeurs des entrées. Par défaut, les valeurs sont mises a 0.
On peut choisir de donner une valeur a la ligne entiére (en cliqguant simplement sur I'entrée souhaitée) ou

a une section de ligne en la sélectionnant avec la souris :

+ [Nl-o
» B BO
‘s s BX
= A BO
» B BO

3

BX




On décide ensuite de la valeur a attribuer O ou 1

R x (& M)E T E B EE X

Une autre option est possible : le compteur
x Q ﬁ«&hi)@)@%)@ﬁ)@ w2 w3 2 | B

Count Value ot . , s .
S Elle permet d’incrémenter I'entrée a chaque période du

Radix: Binary M compteur.

Startvalue: |0 ‘

Increment by: 1

Count type
Binary

Gray code

Transitions occur

Count every: ns




